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Notice

1.

12.

13.
14.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT
TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)’ means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.

Trademarks

Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks

aie the property of their respective owners.

© 2022 Renesas Electronics Corporation. All rights reserved.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit
Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1.

Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must
be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate.
When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices
must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches
and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar
precautions must be taken for printed circuit boards with mounted semiconductor devices.

Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register
settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states
of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is
reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is
specified.

Input of signal during power-off state

Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or 1/O pull-up
power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the
guideline for input signal during power-off state as described in your product documentation.

Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in
the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.
Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution,
wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset,
ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external
resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi (Max.) and
Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed,
and also in the transition period when the input level passes through the area between Vi. (Max.) and V4 (Min.).

Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses
as the correct operation of the LSl is not guaranteed.

Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The
characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal
memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins,
immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given

product.



Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

¢ reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Smart Configurator for RX
together with the e? studio IDE to create a working project for the RSK platform. It is intended for users
designing sample code on the RSK platform, using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e? studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX140 microcontroller may be found in ‘RX140 Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK Web installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX140 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK Renesas Starter Kit for R20UT5026EG
hardware. RX140 User’s Manual
Tutorial Manual Provides a guide to setting up RSK environment, Renesas Starter Kit for R20UT5030EG
running sample code and debugging programs. RX140 Tutorial Manual
Quick Start Guide Provides simple instructions to setup the RSK and Renesas Starter Kit for R20UT5031EG

run the first sample. RX140 Quick Start Guide
Smart Configurator Provides a guide to code generation and importing Renesas Starter Kit for R20UT5032EG
Tutorial into the e? studio IDE. RX140 Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK. Renesas Starter Kit for R20UT5025EG
RX140 Schematics
Hardware Manual Provides technical details of the RX140 RX140 Group User’s RO1UHO0905EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC

Analog-to-Digital Converter

API Application Programming Interface

bps bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

E1/E2 Lite Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

PLL Phase-locked Loop

Prmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification

PSU Power Supply Unit

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Real Time Clock

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TFT Thin Film Transistor

UART Universal Asynchronous Receiver/Transmitter

USB Universal Serial Bus

WwDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.



https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESANS

1. Overview

1.1 Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e? studio
IDE Smart Configurator plug-in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with e? studio.

« Code generation using the Smart Configurator plug-in.
« User circuitry such as switches, LEDs and a potentiometer.

The RSK board contains all the circuitry required for microcontroller operation.

R20UT5032EG0100 Rev.1.00 o
Jan.17.2022 RENESAS



Renesas Starter Kit for RX140 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator plug-in for the RX
family together with the e? studio IDE to create a working project for the RSK platform. The tutorials help
explain the following:

e Project generation using e? studio

o Detailed use of the Smart Configurator plug-in for e? studio
¢ Integration with custom code

¢ Building the project in e? studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug' is a project built with the debugger support included. Optimisation is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and ‘Outputs debugging information’
option not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more
in-depth information.

R20UT5032EG0100 Rev.1.00 S
Jan.17.2022 RENESAS




Renesas Starter Kit for RX140

3. Project Creation with e? studio

3. Project Creation with e? studio

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX140

MCU, ready to generate peripheral driver code using Smart Configurator.

This project generation step is

necessary to create the MCU-specific source, project and debug files.

3.2 Creating the Project

e Start e? studio and select a suitable location
for the project workspace.

Select a directory as workspace

» Recent Workspaces

e’ studio uses the workspace directory to store its preferences and development artifacts.

Workspace: | C¥Workspace ~ Browse...

[JUse this as the default and do not ask again

¢ In the Welcome page, click ‘Create a new
C/C++ project’.
(The Welcome page can also be opened
from 'Help'-> 'Welcome'.)

) Workspace - e studio
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

[ @ Welcome x o]

RENESAS

Welcome to e? studio

Create a new e studio C/C++ project

Import existing €2 studio projects from the
filesystem or archive

Get an overview of the features

Go through tutorials

Try out the samples
Download and import sample projects from v v
Renesas website

Find out what is new
Review the IDE's most fiercely contested
preferences

Quickly getting familiar with the tool

Open a file from the filesystem

[ Aways show Welcome at start up

R20UT5032EG0100 Rev.1.00
Jan.17.2022

RENESAS

Page 9 of 80



Renesas Starter Kit for RX140 3. Project Creation with e? studio

e In the ‘Templates for New C/C++ Project’ | | newc/css project o x
H . 13 il 3
dialog, selecting ‘Renesas RX' -> ‘Renesas | | remplates for New c/c++ Project
H 3
CC-RX C/C++ Executable Project’.
e Click ‘Next’. .
All GCC for Renesas RX C/C++ Executable Project
CMake EEZ A (/C++ Executable Praject for Renesas RX using the GCC
Make for Renesas RX Toolchain.
Renesas Debug . .
Renesas RL78 GCC for Renesas RX C/C+ + Library Project
FE=™ A G/C++ Library Project for Renesas RX using the GCC for
Renesas RX Toolchain.
Renesas CC-RX C/C++ Executable Project
FE==™ A G/C++ Project for Renesas RX using the Renesas CCRX toolchain.
Renesas CC-RX C/C++ Library Project
FE=™ A G/C++ Library Project for Renesas RX using the Renesas
CCRX toolchain.
@ < Back | Finish Cancel
e Enter the project name ‘SC_Tutorial’. Click | |& o x
13 t)
Next'. New Renesas CC-RX Executable Project =<
New Renesas CC-RX Executable Project e}
Project name: | SC_Tutoriall
Use default location
C:¥Workspace¥SC Tutorial Browse...
Create Directory for Project
default
Working sets
[] Add project to working sets New.
Select..
@ < Back Finish Cancel
R20UT5032EG0100 Rev.1.00 RENESANS Page 10 of 80

Jan.17.2022



Renesas Starter Kit for RX140

3. Project Creation with e? studio

e In the ‘Select toolchain, device & debug
settings’ dialog, select the options as shown
in the screenshot opposite.

¢ In ‘Toolchains’ choose ‘Renesas CCRX'.

e The R5F51406BxFN MCU
RX100 -> RX140 ->

RX140 - 144 pin.

e Select 'E2 Lite (RX)' from the pulldown and
check 'Create Release Configuration' check
box.

e Click ‘Next'.

is found under

New Renesas CC-RX Executable Project

Select toolchain, device & debug settings

Toolchain Settings

Language: @c Oc++

Toolchain: Renesas CCRX i

Toolchain Version: | v3.04.00 i
Manage Toolchains...

RTOS: None i

RTOS Version:

Device Settings Configurations

Target Board: |Custom v‘ =

Create Hardware Debug Configuration

Download additional boards... E2 Lite (RX)

Target Device: | RSF51406BxFN |1|

Unlock Devices... RX Simulator

Endian: | Little ~

Project Type: | Default

@ < Back Finish

[] Create Debug Configuration

reate Release Configuration

Cancel

e In the ‘Select Coding Assistant
dialog, select ‘Smart Configurator’.

e Click ‘Next.

settings’

New Renesas CC-RX Executable Project

Select Coding Assistant settings

se Smart Configurator

Use Peripheral Code Generator

modules.
pin configuration view.

drivers and middleware modules will be notified.
(Smart Configurator is available only for the supported devices)

User Application

Driver and Middleware

Driver Code FIT Modules
Configured in GUI Selected in GUI
and Generated and Imported

MCU Hardware

LAA R R RERRRRRRRRRRRRE RN

10jeinSiyuo) Jews

@ < Back

Finish

Smart Configurator is a single User Interface that combines the functionalities of Code Generator and
FIT Configurator which imports, configures and generates different types of drivers and middleware

Smart Configurator encompasses unified clock configuration view, interrupt configuration view and

Hardware resources conflict in peripheral modules, interrupts and pins occurred in different types of

Cancel

R20UT5032EG0100 Rev.1.00
Jan.17.2022

RENESAS
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Renesas Starter Kit for RX140 Project Creation with e? studio
e Click ‘Next’. a8 ooox
New Renesas CC-RX Executable Project —
Settings The Contents of Files to be Generated
What kind of initialization routine would you like to create?
Use Renesas Debug Virtual Console
3 S

@ < Back | Finish Cancel
e A summary dialog will appear, click ‘Finish’to | | @& o X

Complete the prOjeCt generatlon- New Renesas CC-RX Executable Project =<

Summary of project "SC_Tutorial” L |
TOOLCHAIN NAME : Renesas CCRX
TOOLCHAIN VERSION : v3.03.00
GENERATION FILES :
e In future, to skip the pop-up message on the | | @ openasociated perspecive X
right, check the 'Remember my decision' - , ,
. f . f [ Open the Smart Configurator perspective?
check box and click on 'Open Perspective'. 9/
ﬂ?ememher my decision
o [
R20UT5032EG0100 Rev.1.00 RENESAS Page 12 of 80
Jan.17.2022



Renesas Starter Kit for RX140

3. Project Creation with e? studio

The perspective changes automatically when
the Smart Configurator starts up.

- O *

| B~QR v B I/ >vB R H~Q~
Q @ | BC/C++ & Smart Configurator
= O | 51 MCU/MPU Package x = B

= 1Y = L2 1] | »
Generate Report

R20UT5032EG0100 Rev.1.00
Jan.17.2022
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Renesas Starter Kit for RX140 4. Smart Configurator Using the e? studio

4. Smart Configurator Using the e? studio

4.1 Introduction

The Smart Configurator plug-in for the RX140 has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plug-in tool for generating template ‘C’ source code and
project settings for the RX140. When using Smart Configurator, it provides the user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

By following the steps detailed in this Tutorial, the user will generate an e? studio project called SC_Tutorial.
The fully completed Tutorial project is contained in the RSK Web Installer
(https://www.renesas.com/rskrx140/install/e2) and may be imported into e? studio by following the steps in the
Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for e? studio.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion. Results are
displayed via the virtual COM port in a terminal program and also on the PMOD display connected to the RSK.

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator

R20UT5032EG0100 Rev.1.00 RENESAS Page 14 of 80
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4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: e? studio.
You can download the latest document from: https://www.renesas.com/smart-configurator.

The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

Q Vorkspace - SC_Tutorial/SC_Tutorial scfg - e* studic - [m] X

File Edit igate Search Project RenesasViews Run Window Help

4 Debug ~ || [ SC_Tutorial HardwareDebug v [miiRd | B~R @ H V- B R Q- - Wi~ - ¥ ' - ~ |
Q & | BiC/Cr+ | £F Smart Configurator |
5 Project Explor x| ~ B | SC_Tutorialscfg X = 8 =
BT § o : % = al[2ll2llallE @) Assig..>>

&5 SC Tutorial Gz i Generate Code Generate Report E e <19

- General Information @ .
Overview

Get an overview of the features provided by

Smart Configurator.
Application Code

Videos - 4

Introduction to Smart Configurator Software Components
Browse related videos | Iddleware &

RENESAS

D
)

RXI40

What's New

Check out what's new in the latest release.

Product Documentation MCU Hardware

User manual and release notes

Application Notes
Tool news

Device Drivers
RSFS14068KFN

JojeIngiyuo) pews

~ Current Configuration

Selected board/device: R5F51406BxFN (ROM size: 256KB, RAM size: 64KB, Pin count: 80) hdl| K
Overview | Board | Clocks| System | Components | Pins| Interrupts » lLegend
& Console x R M-Sy =0 [ Configuration Problems x ¥ § =0
Smart Configurator Output 0items
MPbBBBEZ2: File generated:src\smc gen\general\r smc interrupt.h ~ . ~
| Description Type

M@3000004: File modified:srchsmc gen\r confighr bsp config.h
1MP@PAARA2: Code generation is successful:C:\Workspace\SC Tutoriallsrc\smc gen

<R

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured e? studio project that builds and runs without error.
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4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-2.

F3
E-

Device selection

Board: |Custom User Board M

Device: |RSF51406BxFN

Download more boards...

Overview [Board| Clocks| System | Components | Pins| Interrupts

Figure 4-2 Board configuration page

4.31 Board configuration page

Make sure that ‘Custom User Board’ is selected for the ‘board:’.

Device selection

Device selection

Board: | Custom User Board o

Device: | R5F51406BxFN

Download more boards..

Figure 4-3 Select board
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4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected in the
r_bsp_config.h file in \src\smc_gen\r_config.

441 Clocks configuration

Figure 4-4 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on board 8 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-4.

0|
- . O =
Clocks configuration Generate Code Generate Report
1|
VoG | 33 V) (Actusl value: 3.3)
v PLL circuit
Main clock Fracuancy Civition
Oscillation source: | Resonator
=1 x
Frequency: | 8 (MHz) i -
Frequency Multiplication: SCKCR (FCKI3:00) FlashiF clock (FCLK)
SCKCR (ICK[3:00) System chock (ICLE)
P | ry %1 48 (MHz)
Sub-clock
SCKCR (PCKB[3:01) Peripheral module clock (PCLEB)
x1/2 24 [MHz)
SCKCR (PCKD{3:00 Periphiral module clock (PCLED)
=1 » 48 {(MHz)
HOCO clock
0CO cioe
CLEQUT pin

IWDT-dedicated low-speed clock

LB
CKOCR {CKODIV[20])
J x1/8 >

CANMCLK/CACMELK
8 {MHz)

Overview Board |Clocks|System Components| Fins| Interrupts

Figure 4-4 The ‘Clocks’ tabbed page
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4.5 The ‘System’ tabbed page

Set the On-chip debug setting mode on the ‘System’ tabbed page.

il =

SYStem conflguratlon Generate Code Generate Report

[G]

~ On-chip debug setting
Debug interface setting
(® Unused () FINE

Overview | Board | Clocks| System JComponents| Pins| Interrupts

Figure 4-5 The ‘System’ tabbed page
4.51 On-chip debug

The On-chip debug settings set the interface used for debugging. For the RSKRX140 CPU board, select
JTAG as shown in Figure 4-6.

= On-chip debug setting
Debug interface setting
(O Unused @ FINE

Figure 4-6 Debug interface setting
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4.6 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The ‘Components’ page
allows the user to select and configure software components.

Software component configuration

Components i1 5 |%. =] = 3 Configure

W

~ [= Startup
~ = Generic
% rbsp

Overview |[Board Clocks SystemlComponentslPins Interrupts

Figure 4-7 Components page

4.6.1 Add a software component into the project

Smart Configurator supports five types of software components: Startup, Drivers, Middleware, Application and
RTOS. In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple
project containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ & icon.

Software component configuration

Components @23 7 = 3 Configure

"

~ [= Startup
~ [= Generic

% r_bsp
Figure 4-8 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
&) New Component O X

Software Component Selection tlj

Select component from those available in list

Category |All ~
Function All

Startu
Filter

Middleware

CompomApplication
8 8-Bit TINO>

Figure 4-9 Add a Software component (2)
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4.6.2 8-Bit Timer

TMRO will be used as an interval timer for generation of accurate delays. Select ‘8-Bit Timer’ as shown in
Figure 4-10 below then click ‘Next'.

& New Component

Software Component Selection

Select component from those available in list

Category IDrivers

Function |All ™
Filler |

Components 3 Short Name Type Version

£ 8-Bit Timer Code Generator  1.9.0 I

£ Buses Code Generator  1.10.0

# Clock Frequency Accuracy Measurem... Code Generator  1.10.0

£ Clock Synchronous Control Module f..  r_flash_spi Firmware Integ.. 3.03

B CMT driver r_cmt_rx Firmware Integ.. 5.00

# Comparator Code Generator  1.8.0

# Compare Match Timer Code Generator  2.20

£ Complementary PWM Mode Timer Code Generator  1.10.0

# Continuous Scan Mode S12AD Code Generator  1.12.0

H# Control Low Power States. r_lpc_rx Firmware Integ.. 2.03

# CRC Calculator Code Generator  1.10.0

B CTSU QE API r_ctsu_ge Firmware Integ... 2.01 v

Show only latest version
Hide items that have duplicated functionality
Description

This software component generates two units (unit 0, unit 1) of an on-chip 8-bit timer (TMR)
module that comprise two 8-bit counter channels, totaling four channels.

Download the latest FIT drivers and middleware

Configure general settings...

® < Back

I Next > I Finish |

Cancel

Figure 4-10 Select 8-Bit Timer
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In ‘Add new configuration for selected component’ dialog -> Resource, select ‘TMRO0’ as shown in Figure 4-11

below.

& New Component O * l
Add new configuration for selected component tB
8-Bit Timer

Configuration name: :C-::-nfig_TMRD

Count mode: 8 bit w

Resource:

Figure-4-11 Select Resource - TMRO

Ensure that the ‘Configuration name’ updates to ‘Config_ TMRO’ as shown in Figure 4-12 below then click

‘Finish’.
{8} New Component O * l
Add new configuration for selected component t{:} I
8-Bit Timer
Configuration name: IConfig_TMRO I
Count mode: 8bit o
Resource: TMRO b
@ < Back Next > Cancel
Figure 4-12 Ensure Configuration name - TMRO
R20UT5032EG0100 Rev.1.00 RENESAS Page 21 of 80
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In ‘Config_TMRO’, configure TMRO as shown in Figure 4-13. This timer is configured to generate a high
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

Components i % . - + 3¢ v Configure
L Count setting
|type filter text | Clock source IPCI.K!‘I 024 ~ I
v & Startup s Counter clear Cleared by compare match A v I
v & Generic
% rbsp Compare match A value (TCORA) 1 ms ~
= —— -
v & Drivers Compare match B value (TCORB) 1 ms
v & Timers "
& Config TMRO T_MOO output setting
[C] Enable TMOO output
No change
No change
Interrupt setting
natlle TCORA compare match interrupt (CMIAD)
[] Enable TCORE compare match interrupt (CMIBO)
[ Enable TCNT overflow interrupt (OVIO)
Priority ILeveI 10 VI
Figure 4-13 Config_TMRO setting
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4.6.3

Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMTO0 and CMT1 will be used as
timers in de-bouncing of switch interrupts.
Select ‘Compare Match Timer’ as shown in Figure 4-14 below then click ‘Next'.

& New Component O bt
Software Component Selection EH
Select component from those available in list
Category |Drivers I/
Function | All v
Filter |
. Components Short Name Type Version ~ I
I B8 8-Bit Timer Code Generator 190
i Buses Code Generator 1,100
8 Clock Frequency Accuracy Measurem... Code Generator  1.10.0
# Clock Synchronous Control Module f..  r_flash_spi Firmware Integ.. 3.03
## CMT driver r_emt_nc Firmware Integ.. 5.00
# Comparator Code Generator  1.8.0
I # Compare Match Timer Code Generator  2.2.0 I
' H# Complementary PWM Mode Timer Code Generator  1.10.0
# Continuous Scan Mode S12AD Code Generator 1.12.0
## Control Low Power States. r_Ipc_m Firmware Integ.. 203
#8 CRC Calculator Code Generator  1.10.0
| 8 CTSU QE API r_ctsu_ge Firmware Integ.. 2.01

Show only latest version

Hide items that have duplicated functionality

Description

W |

This software component provides configurations for 16-bit/32-bit timer with module
CMT/CMTW and can generate interrupts at set intervals.

Download the latest FIT dnvers and middleware

Configure general settings...

\ 9: < Back

Next >

Finish |

Figure 4-14 Select Compare Match Timer

Cancel
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In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTO’ as shown in Figure 4-15
below.

&) New Component O * |

Add new configuration for selected component t{j

Compare Match Timer
Configuration name: | Config_CMTO

Resource: CMTO o+ I
@ < Back Next > Cancel

Figure 4-15 Select Resource - CMTO0

Ensure that the ‘Configuration name’ updates to ‘Config_ CMTO’ as shown in Figure 4-16 below then click
‘Finish’.

&) New Component O X |
Add new configuration for selected component ttj
Compare Match Timer
Configuration name: I-Confiq _CMTO I
Resource: CMTO v

\L < Back

Figure 4-16 Ensure Configuration name - CMTO

In ‘Config_CMTO’, configure CMTO as shown in Figure 4-17. This timer is configured to generate a high
priority interrupt every 20ms. We will use this interrupt later in the tutorial to provide an API for generating
high accuracy delays required in our application.

Components fued 2 O ® 3 v  Configure
L Count clock setting
|| | () PCLK/B @ PCLK/32 O PCLE/128 () PCLK/512
v (= Startup | Compare match setting
v & Generic Interval value Izg I Ims VI'I“"\"IJ-?! value: 20)
% rbsp -
+ = Drivers Register value (CMCOR) 14999
v & Timers Compare match interrupt (CMIO)
w« Config CMTO Priarity Iiﬂel 10 "I
@ Config_TMRO

Figure 4-17 Config_CMTO setting
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Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT1’ as shown in Figure 4-18 below.

&) New Component O X ‘

Add new configuration for selected component tH

Compare Match Timer

Configuration name: -Config_( MTO1

Resource: |CMTO ™ |

——

@ < Back Next > Cancel

Figure 4-18 Select Resource — CMT1

Ensure that the ‘Configuration name’ updates to ‘Config_CMT1’ as shown in Figure 4-19 below then click

‘Finish’.
&) New Component O X ‘
Add new configuration for selected component tl:f
Compare Match Timer
Configuration name: ICanig_CMT] I
Resource: CMT1 ol
Q < Back Next > ‘ Cancel
Figure 4-19 Ensure Configuration name — CMT1
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Navigate to the ‘Config_CMT1’ and configure CMT1 as shown in Figure 4-20. This timer is configured to

generate a high priority interrupt after 200ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

Components 2l = 3 v  Configure
" s Count clock setting
|type filter text OpCLK/a O PCLK/32 (D PCLK/128 @ PCLK/512
~ = Startup ~ Compare match setting
v & Generic Interval value IZOO I Ims vI-Ar-—.u.-;l value: 200)
% rbsp — ]
v @ Drivers Register value (CMCOR) 9374
v (& Timers Compare match interrupt (CMI1)
@ Config CMTO Priority ILeveI 10 a I
« Config CMT1
@ Config_TMRO

Figure 4-20 Config_CMT1 setting
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4.6.4 Interrupt Controller

Referring to the RSK schematic, SW1 is connected to IRQ1(P31) and SW2 is connected to IRQ2(P32). SW3
is connected to IRQ6(P16) and ADTRGONn. This tutorial uses ADTRGOnN, which will be configured later in
section 4.6.8.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Interrupt Controller’ as shown in Figure 4-21 then click ‘Next'.

&) New Component O * |

Software Component Selection

Select component from those available in list

Category [Drivers

Function | All
Filter |
Components Short Name Type Version ™
B Flash API for RX100, RX200, RX600. a.. r_flash_nx Firmware Integ.. 4.81
# Group Scan Mode 512AD Code Generator  1.11.0
B 12C Master Mode Code Generator 1110
B 12C Slave Mode Code Generator  1.10.0

| # Interrupt Controller Code Generator  2.2.0
B Low Power Consumption Code Generator 220
8 Low Power Timer Code Generator 140
# Normal Mode Timer Code Generator  1.11.0
% Phase Counting Mode Timer Code Generator 2.3.0
& Port Output Enable Code Generator 1,100
H# Ports Code Generatar  2.3.0
B PWM Mode Timer Code Generator  1.11.0

Show only latest version

Hide items that have duplicated functionality

Description
Interrupt Controller configures the interrupt requests generated by ICU: Software interrupt,
NMI pin interrupt and IRQ External pin interrupts.

Download the latest FIT drivers and middieware

Configure general settings...

@ < Back | Next > | [ Finish | Cancel

Figure 4-21 Select Interrupt Controller
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In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-22
below then click ‘Finish’.

&) New Component O X |

Add new configuration for selected component t}j

Interrupt Controller

Configuration name: Itcnfig_lCU I

Resource: Icu w

Figure 4-22 Select Resource - ICU
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Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-23

below.
& o x|
—
Sof £ i =]
HES EOMIRES t comn guratlon Generate Code Generate Report
Components 2yl L = 4 3 v Configure @
L Software interrupt setting
| [ Software interrupt F Level 15 (highest)
v & Startup '\j .
e i TMI pin interrupt setting
% rbsp [C]NMI pin interrupt )] Falling edge Jigita No filter 0 M
v & Dnvers
« & Imemupt IRQO setting
« Config_ICU JIrQo L Low level gital f Nao filter 0 MHz
v & Timers Level 15 (highest)
& Config_CMTO
@ Config CMT1 IRQ1 setting
@ Config TMRO IRQW Detection type JFalling edge Digital filter | Mo filter ~ 0 M
Priority Level 15 (highest) L
IRQ2 setting
RQZ Detection type [Falling edge Digital filter |No filter ~ 0 MHz
Priority Level 15 (highest) v
IRQ3 setting
I leF] ype |Low level jital f No filter 0 M
Level 15 (highest)
IRQM setting
CJirqs [ Low level Yigita No filter 0 M
Level 15 (highest)
IRQ5 setting
1rQs [ T Low level yital f Nao filter 0 M
Level 15 (highest)
IRQG setting
[CJirae L Low level Yigital f No filter 0 Mt
Level 15 (highest)
IRQ7 setting
DIRQT [ Low level yital f Mo filter 0 MHz
Lewvel 15 (highest)
Overview | Board | Clocks | System | Components| Pins| Interrupts
Figure 4-23 Config_ICU setting
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4.6.5 Ports

Referring to the RSK schematic, LEDO is connected to P21, LED1 is connected to P04, LED2 is connected to
P06 and LED3 is connected to PO7. PB2 is used as one of the LCD control lines, together with PE4, PC7 and
PC6.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Ports’ as shown in Figure 4-24 then click ‘Next'.

&) New Component O

X
Software Component Selection t&

Select component from those available in list

Category IDrivers Iv
Function  All v
Filter | !
Components : Short Name Type Version
B Low Power Timer Code Generator  14.0
## Normal Mode Timer Code Generator  1.11.0
B Phase Counting Mode Timer Code Generator  2.3.0
B Port Output Enable Code Generator__1.10.0
[ ports Code Generator 230 |
B PWM Mode Timer Code Generator  1.11.0
f# Real Time Clock Code Generator  1.7.0
& RSPI Driver T_rspi_rx Firmware integ.. 3.03
£ SCI Driver r_sci_m Firmware Integ.. 4.10
# SCI/SCIF Asynchronous Mode Code Generator  1.11.0
B8 SCI/SCIF Clock Synchronous Mode Code Generator  1.11.0
| & Simple IIC Driver. r_sci_jic_rx Firmware Integ.. 249 ]

Show only latest version
Hide items that have duplicated functionality

Description
This software component provides configurations for General Purpose Input/Cutput. N
Commaon features such as reading, writing, and setting the direction of ports and pins can be
configured. Enabling features such as open-drain outputs and intermal pull-ups are also v

Download the latest FIT dnivers and middleware

Configure general settings...

@ < Back I Next » I[ Finish Cancel

Figure 4-24 Select Ports
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In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-25

below then click ‘Finish’.

&) New Component O * ‘
Add new configuration for selected component tH
Ports

Configuration name: |[Config_PORT

Resource: PORT »

I:'?' < Back e Cancel

Figure 4-25 Select Resource — PORT

Tick the tickboxes for ‘PORTO’, ‘PORT2’, ‘PORTB’, ‘PORTC’ and ‘PORTE’ as shown in Figure 4-26 below.

Components ¢ b > = + 3 Configure £
3 - = Port selection PORTO PORT2 PORTB PORTC PORTE
| type filter text |
w [& Startup N
« & Generic PORTO ] PORT1
% r_bsp '
< Dhiiare PORT2 ] PORT3
v & Interrupt []1PORT4 ] PORTS
& Config_ICU
~ & 1/O Ports [JrORTA [l PORTE
« Config_PORT
v @& Timers PORTC C1PORTD
@ Config_CMTO -
~| PORTE PORTG
& Config CMT1 O
@ Config TMRD []PORTH (] PORT)

Figure 4-26 Select Port selection
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Navigate through each of the 'PORTX' tabs, configuring these four I/O lines and LCD control lines as shown in
Figure 4-27, Figure 4-28, Figure 4-29, Figure 4-30 and Figure 4-31 below. Tick the tickboxes for ‘Out’ and

tick ‘Output 1’ the tickboxes except for PC6 under the ‘PORTC’ tab. Start with the 'PORTO' tab.

Components i=3 .t . - + 3 » Configure o fad
s -
Port sel PORTO
PR selectiorf PORTO | PORT2 PORTB PORTC PORTE
||f1'D?fI|.F' text |
~ & Startup ~
Apply to all
~ & Generic LApplyt0a
- Unused GPIO Out Pull-up Output 1
% rbsp
~ & Drivers
~ & Interrupt P03
@ Config_ICU @®UnusedGPI0 OIn O out  [JPull-up Qutput 1
v & I/O Ports
« Config_PORT Po4
~ & Timers O Unused GPIO Ol In | @ Out Pull-up Oulpl.rt 1
@ Config_CMTO
@ Config_CMT1 P05
« Config_TMRO ®unusedGPI0 Oin Qout  [JPull-up Output 1
POG
Ounused GPIO O'in Pull-up [ Output 1
P07
o OUnused GPIO O In Pull-up ] Output 1
b4
Figure 4-27 Select PORTO tab
Select ‘PORT2’ tab.
Components = .5 " | # 3~ Configure A e
-
Port sel PORT2
P selection PORTO | PORT2 | PORTB PORTC PORTE
|type filter text |
~ (& Startup -
v i i [ Apply to all
% rbsp Unused GPIO Out Pull-up | CMOS output Cutput 1
~ & Drivers
~ & Interrupt P20
@ Config_ICU @unusedGPIO0 Oin Oout [JPull-up  CMOS output ~ Output 1
v & /O Ports
« Config_PORT P21
~ & Timers OUnused GPIO Ol in | @ Out Pull-up  CMOS output ~
@ Config_CMTD
@ Config CMT1 P26
@ Config TMRO @ Unused GPIO OIin O 0Out [JPull-up  CMOS output w Cutput 1
P27
@Unused GPIO O'in QOut [JPull-up  CMOS output - Output 1
Figure 4-28 Select PORT2 tab
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Select ‘PORTB’ tab.

Components i e . = = 3¢ v Configure @ ~
_ " Port selection PORTO PORT2 PORTC PORTE
| type filter text
~ & Startup -
« & Generic DApply to all
% rbsp Unused GPIO In Out Pull-up  |CMOS output Qutput 1
w & Drivers
v = Interrupt PBO
« Config_ICU ®Unused GPIO Oin Oout [JPull-up | CMOS output Output 1
~ & /O Ports
« Config_PORT PB1
v & Timers ®Unused GPIO Oin Oout [JPull-up  CMOS output Output 1
@ Config CMTO
@ Config_CMT1 PB2
@ Config TMRO (O Unused GPIO (D In | @ Out Pull-up | CMOS output [~] Output 1
PB3
®Unused GPIO Oin O out [JPull-up  CMOS output Output 1
PB4
@®Unused GPIO Oin O out [JPull-up  CMOS output Output 1
PBS
@ Unused GPIO O'in O out [JPull-up | CMOS output Output 1
PBE
@®Unused GPIO Oin Oout [JPull-up | CMOS output Output 1
PB7
® Unused GPIO (Oin O 0Out  [JPull-up | CMOS output Output 1
Figure 4-29 Select PORTB tab
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Select ‘PORTC’ tab.

Components =3 5 ©. - + 33 v Configure (ha ~
L
PORTC
| . Port selection PORTO PORT2 PORTB PORTE
| type filter text
~ & Startup ~
vl v ] Apply to all
1S r_bsp Unused GPIO In Out Pull-up  CMOS output Output 1
v & Drivers
~ & Interrupt PCo
@ Config_ICU @ Unused GPIO (COin O 0Out  [JPull-up | CMOS output Output 1
~ & 1/O Ports
« Config_PORT PC1
v & Timers @ uUnused GPIO O'in O0Out [JPull-up | CMOS output Output 1
@ Config CMTO
@ Config CMT1 PC2
& Config TMRO @Unused GPIO O'in O out [JPull-up | CMOS output Output 1
PC3
®Unused GPIO O'in Oout [JPull-up  CMOS output Output 1
PC4
®Unused GPIO O'in Oout [JPull-up CMOS output Output 1
PC5
®Unused GPIO O'in O0Out [JPull-up | CMOS output Output 1
PC6
(O Unused GPIO O In | @ Out Pull-up | CMOS output [ output 1
PC7
O Unused GPIO (O In Pull-up | CMOS output [+] Output 1
Figure 4-30 Select PORTC tab
Select ‘PORTE'’ tab.
Components i 1 |* - + 3 v Configure (I ~
it Port selection PORTO PORT2 PORTB PORTC
Irype filter text
~ & Startup Ll
A [JApply to all
% rbsp Unused GPIO In Qut Pull-up Output 1
~ @& Drivers
~ & Interrupt PEO
@ Config_ICU @Unused GPIO Oin Qout [JPull-up | CMOS output Output 1
v & IfO Ports
« Config PORT PE1
~ & Timers ®uUnusedGPIO Oin Oout [JPull-up  CMOS output Output 1
@ Config_CMTO
@ Config_CMT1 PE2
& Config TMRO @UnusedGPIO Otn Oout [JPull-up | CMOS output Output 1
PE3
@®Unused GPIO O'in O out  [JPull-up  |CMOS output Output 1
PE4
O Unused GPIO C'in | @ Out Pull-up [~] Output 1
PES
@ Unused GPIO O'in O 0Out [ Pull-up Output 1
Figure 4-31 Select PORTE tab
ev.1. - age 34 o
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4.6.6 SCI/SCIF Asynchronous Mode
In the RSKRX140, SCI1 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as shown
in the schematic.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select
‘SCI/SCIF Asynchronous Mode’ as shown in Figure 4-32 then click ‘Next'.

ﬁ New Compeonent O x ‘
Software Component Selection tH’
Select component from those available in list
Category IDtivers I o
Function |All -
Fiter | |
Components : Short Name Type Version #
B RSPI Driver _rspi_nc Firmware Integ.. 3.03
£ SCI Driver T_SCi_X Firmware Integ... 4.10
| # sciscIF Asynchronous Mode Code Generator 1110 |
# SCI/SCIF Clock Synchronous Mode Code Generator  1.11.0
& Simple IIC Driver. r_sci_iic_r Firmware Integ.. 249
f# Single Scan Mode $12AD Code Generator  2.4.0
# Smart Card Interface Mode Code Generator  1.11.0
8 SPI Clock Synchronous Mode (3-wire ... Code Generator 1.11.0
# 5P| Operation Mode {4-wire method) Code Generator 1.9.0
# Voltage Detection Circuit Code Generator  1.10.0
# Watchdog Timer Code Generator  1.10.0
|
Show only latest version
Hide iterns that have duplicated functionality
Description
This software component provides configurations for SCI{SCIF) single{multi-processor)
asynchronous mode.
Download the latest FIT dnvers and middleware
Configure general settings...
'? < Back I Next > I [ Finish | Cancel
Figure 4-32 Select SCI/SCIF Asynchronous Mode
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In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as
shown in Figure 4-33 below.

{8 New Component O X ‘
Add new configuration for selected component {ZH '
p

SCI/SCIF Asynchronous Mode

Configuration name: | Config_SCI1

Work mode: Transmission

Resource:

Transmission/Reception
Multi-processor Transmission
Multi-processor Reception
Multi-processor Transmission/Reception

L 7 < Back Next > Cancel

Figure 4-33 Select Work mode — Transmission/Reception

In ‘Resource’, select ‘SCI1’ as shown in Figure 4-34 below.

&) New Component O x ‘
Add new configuration for selected component tﬁ

|

SCI/SCIF Asynchronous Mode |

Configuration name: | Config_SCI1

Work mode: Transmission/Reception

Resource:

@ < Back Next > Cancel

Figure 4-34 Select Resource — SCI1
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Ensure that the ‘Configuration name’ updates to ‘Config_SCI1’ as shown in Figure 4-35 below then click

‘Finish’.

{8} New Component O

Add new configuration for selected component
SCI/SCIF Asynchronous Mode
Configuration name: I Config_SCI1
Work mode: Transmission/Reception
Resource: scn
ke e ] ome

Figure 4-35 Ensure Configuration name - Config_SCI1
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Configure SCI1 as shown in Figure 4-36. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD1 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

fe] ] x
£ *SC_Tutorial.scfg =0
i ic! =)
Software component configuration Geremis Codle. Gerenat=Henon
Components 25 ed % 5 4 3+ Configure (L} A
% 5 Start bit edge detection setting
| O Low level on RXD1 pin I @ Falling edge on RXD1 pin I
v (& Startup o Data length setting
v & Generic O9bits ®8bits O7bits
% rbsp . )
<@ Diivers Parity setting
v & Interrupt @ None (O Even O odd
@ Config ICU Stop bit length setting
v & I/OPorts @ 1bit O 2bits
« Config_PORT — -
. i Commurications Transfer direction setting
& Config_SCi1 (@ LSB-first (O MsB-first
v 2 Tl_mers Data inversion setting
@ Config CMTO ® Normal O Inverted
@ Config CMT1
@ Config_TMRO I_nstant transmission setting
[JEnable instant transmission
Transmitter output setting
® Normal O Inverted
Receiver input setting
® Normal O Inverted
Transfer rate setting
Transfer clock Internal clock ~
Base clock 16 cycles for 1-bit period b
Bit rate | 19200 | ~| tes) (Actual vatue: 19230.769, Error: 0.16%)
[[JEnable modulation duty correction
SCK1 pin function SCK1 is not used =
Transfer timing adjustment setting
[ Adjust transmit signal transition Does not change the waveform
[ Adjust receive data sampling 3 clocks later than default point
Noise filter setting
[“1Enable noise filter
I file Clock signal divided by 1 24000000
Hardware flow control setting
® None OcTs1# ORTS1#
Data match detection setting
[ Enable data match detection
arison data 0x00
Data handling setting
Transmit data handling Data handled in interrupt service routine b
Receive data handling Data handled in interrupt service routine
Interrupt setting
Enable reception error interrupt (ERIT)
TXI1, RXI1, TEI, ERIT priority Level 15 (highest) v
Callback function setting
|\/] Transmission end = Reception end | Reception error
~
Figure 4-36 Config_SCI1 setting
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4.6.7 SPI Clock Synchronous Mode

In the RSKRX140, SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in
the schematic. Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select

‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as shown in Figure 4-37 then click ‘Next'.

ﬁ New Component

Software Component Selection

Select component from those available in list

a s

Category I Drivers I ~
Function |All ~
Filter | |
Components Short Name Type Version * |
# Real Time Clock Code Generator 1.7.0
i RSPI Dniver r_rspi_rx Firmware Integ.. 3.03
# SCI Driver T_SCi_rx Firmware Integ.. 4.10
B SCI/SCIF Asynchronous Mode Code Generator 1.11.0
8 SCI/SCIF Clock Synchronous Mode Code Generator  1.11.0
& Simple IIC Driver. r_sCi_lic_rx Firmware Integ.. 249
i Single Scan Mode S12AD Code Generator 2.4.0
# Smart Card Interface Mode Code Generator  1.11.0
| # sPI Clock Synchronous Mode (3-wire .. Code Generator 1110 |
# SPI Operation Mode (4-wire method) Code Generator  1.9.0
# Violtage Detection Circuit Code Generator 1,100
| # Watchdog Timer Code Generator 1100 ¥

Show only latest version
Hide items that have duplicated functionality
Description

This component provides clock synchronous operation of

{Simple 5P1 bus). It

includes 4 transfer modes: Slave transmit/receive, Slave transmit, Master transmit/receive and

Master transmit,

Download the latest FIT drivers and middleware

Configure general settings...

'9 < Back I Next > I [

Finish |

Cancel

Figure 4-37 Select SPI Clock Synchronous Mode
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In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown

in Figure 4-38 below.

& New Component

Add new configuration for selected component

SPI Clock Synchronous Mode (3-wire method)
Configuration name: | Config_RSPIO

Operation; Slave transmit/receive

Slave transmit/receive
Slave transmit only
Master transmit/receive
Master transmit only

Resource:

_'-I?igure 4-38 Select Operéﬁm — Master transmit only

In ‘Resource’, select ‘SCI6’ as shown in Figure 4-39 below.

& New Compeonent

Add new configuration for selected component

SPI Clock Synchronous Mode (3-wire method)
Configuration name: | Config_RSPIO

x

Operation: Master transmit only

Resource: RSPIO

RSPIO
scn

SCI8
SCI9
S5CN2

foe

Figure 4-39 Select Resource — SCI6
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Ensure that the ‘Configuration name’ updates to ‘Config_SCI6’ as shown in Figure 4-40 below then click
‘Finish’.

& New Component O X ‘

Add new configuration for selected component tB

SPI Clock Synchronous Mode (3-wire method)

Configuration name: ICanig_SCiE I
Operation: Master transmit only w
Resource: SCl6 v

Figure 4-40 Ensure Configuration name - Config_SCI6

Configure SCI6 as shown in Figure 4-41. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 6000 kbps. All other settings remain at their defaults.

Components i i . - + ¥ Configure
. Transfer direction setting
| type filter text O LSB-first (® MSB-first
v & Startup - z
v & Generic [.}ata inversion setting
% r_bsp (@ Normal O Inverted
v 2 Dnvers
v @ Intemupt Transfer speed setting
& Config_ICU Transfer clock Internal clock (SCK6 pin functions as clock output pin) o
v & I/O Pons
Bit rate {kbps {Actual value: 6000, Error; 0%)
& Config_PORT . SER . ;
~ (& Communications [[] Enable modulation duty corection
i 1
- Confnlg el Clock setting
« Config_SCI6
v & Timers [l Enable clock delay [ Enable clock polarity inversion

@ Config_CMTO
@ Config_CMT1
@ Config_TMRD Transmit data handling Data handled in intermupt service routine v

Data handling setting

Interrupt setting

TXI6, TEI6 priority Level 15 (highest) -

Callback function setting

[] Transmission end

Figure 4-41 Config_SCI6 setting
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4.6.8 Single Scan Mode S12AD

We will be using the S12AD in Single Scan Mode on the ANOOO input, which is connected to the RV1
potentiometer output on the RSK. The conversion start trigger will be via the pin connected to SW3. Click the

‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘Single
Scan Mode S12AD’ as shown in Figure 4-42 then click ‘Next'.

{8} New Compenent O

X
Software Component Selection tB

Select component from those available in list

Category I Drivers

BT

Function | All ~
Filter |
Components . Short Name Type Version #

£ RSPI Driver r_rspi_n Firmware Integ.. 3.03
8 SCI Driver r_SCi_rx Firmware Integ.. 4.10
B8 5C1/SCIF Asynchronous Mode Code Generator 1.11.0
B8 SCI/SCIF Clock Synchronous Mode Code Generator  1.11.0
£ Simple IIC Drivﬂ r sci ilc n F'rEnwa re Inte_g .. 249
I B Single Scan Mode S12AD Code Generator  2.4.0 I
8 Smart Card Interface Mode Code Generator  1.11.0
B SPI Clock Synchronous Mode (3-wire ... Code Generator 1.11.0
& SPI Operation Mode (4-wire method) Code Generator 1.9.0
B Violtage Detection Circuit Code Generator  1.10.0
B Watchdog Timer Code Generator  1.10.0

Show only latest version

Hide items that have duplicated functionality

Description

' This software component provides single scan mode configurations for 12-Bit A/D Converter
which the analog inputs arbitranly selected are converted for only once in ascending channel
order. |

Download the latest FIT dnivers and middleware

Configure general settings...

@ < Back I Next > Il Finish I Cancel

Figure 4-42 Select Single Scan Mode S12AD
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Ensure that the 'Configuration name' is'Config_S12AD0' as shown in Figure 4-43 below then click ‘Finish’.

&) New Component O et ‘
Add new configuration for selected component tb‘
Single Scan Mode S12AD
Configuration name: Itonhg_S‘IEADD I

Resource: S12AD0

Figure 4-43 Ensure Configuration name - S12AD0
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Configure S12ADO0 as shown in Figure 4-44 and Figure 4-46 and Figure 4-45. Ensure the ‘Analog input
channel tick box for ANOOO is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’.
All other settings remain at their defaults.

Components o ol

type filter text

v & Startup
v & Genenc
% rbsp
w & Drivers
v & Interrupt
@ Config_ICU
~ & A/D Converter
@ Config_S12AD0
~ & /O Ports
@ Config_PORT
~ & Communications
@ Config_SCI
& Config_SCI6
~ & Timers
@ Config_CMTO
@& Config_CMT1
@ Config_TMRD

Configure

~ Basic setting

Mote
When the 12-bit A/D converter is used, output from port 4 should not be used

Analog input mode setting
[[] Double trigger mode

Analog input channel setting

[ JANOOD [JANOO1 ] ANDO2 []ANDO3 ] ANDOD4
] anoos ] AnDOE [ anoo7 [J anpos CJanD16
] AND17 [JaNO18 [JANO19 [JAND20 [CJAND21
[ anp24 ] ano2s O ano26 ] Temperature sensor output

[]Internal reference voltage

Conversion start trigger setting

Start tigger source

| A/D conversion start trigger pin

Interrupt setting
Enable AD conversion end interrupt (S12ADI0)  Prionity  |Level 15 (highest) ~

= Advance setting
Add/Average AD value setting
] anooo ANDO1

ANODO4

A/D conversion select

(@ High-speed O Low-current

Conversion cycle select

@3 cycles per bit Q2 cycles per bit

High-Potential reference voltage setting
@ Avcco (O VREFHO

Low-Potential reference voltage setting
@ Avsso (O VREFLO

Self diagnosis setting
Maode Unused v

Figure 4-44 Config_S12AD0 setting (1)
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v & Startup
~ & Generic
% rbsp
~ & Drivers
v & Interrupt
@ Config_ICU
v & A/D Converter
& Config_S12AD0
~ & I/O Ports
@ Config_PORT
~ & Communications
& Config_sCI
@ Config_SCI6
~ = Timers
@ Config_CMTO
@ Config CMT1
@ Config_TMRO

Disconnection detection assist setting

Charge setting

Period

Data registers setting

Data placement

Automatic clearing
Addition/Average mode select
Addition count

Data storage buffer setting
(@ Disable

Window function setting
@ Disable

Window A/B operation setting
[JEnable comparison window A

A/D comparison A setting
Reference data 0 for comoa
{ate 1 forcomparicos

Use comparator for ANDOO
Use comparator for ANOOT
Use comparator for AN0ODO2
Use comparator for ANOO3
Use comparator for ANOD4
Use comparator for ANOOS
Use comparator for ANODS
Use comparator for ANOO7
Use comparator for ANOOS
Use comparator for ANO16
Use comparator for ANO17

Use comparator for ANQ18

Unused

2 ADCLK

Right-alignment

Disable automatic clearing
Addition mode

1-time

(O Enable

O Enable

[JEnable comparison window B

Window A comparison cond

0
Reference data 0
Reference data 0

Reference data 0

Reference data 0

Reference data 0
Reference data 0
Reference data 0
Reference data 0
Reference data 0
Reference data 0
Reference data 0

Reference data 0

- A/D-converted value
> ASD-converted value
> A/D-corverted value
> A/D-converted value
> A/D-converted value
> AfD-converted value
> ASD-converted value
> A/D-converted value
> A/D-converted value
> A/D-converted value
> AfD-converted value

= A/D-converted value

Figure 4-45 Config_S12AD0 setting (2)
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~ 2 Drivers Use comparator for ANO19 Reference data 0 > A/D-converted value
v & Interrupt o = =
- : Use comparator for ANO20 Reference data 0 > A/D-converted value
@ Config_ICU
v & A/D Converter Use comparator for AND21 Reference data 0 > A/D-converted value
| « ”
I w Co lf'g—S1MDD Use comparator for AND24 Reference data 0 > A/D-converted value
~ & |/O Ports
& Config_PORT Use comparator for AN025 Reference data 0 > A/D-converted value
v e c_omm“mca“a”s Use comparator for AN0O26 Reference data 0 > A/D-converted value
@ Config_5C11
e Config_SCI6 Use comparator for Temperature sensor output Reference data 0 > A/D-converted value
v & Timers Use comparator for Internal reference voltage Reference data 0 > A/D-converted value
@ Config_CMTO
& Config_CMT1 A/D comparison B setting
@ Config_TMRO R i data AR B 0
1ata 1 for comparisor 0
k anr Unused
Reference data 0 > A/D-converted value
Input sampling time setting
ANO000/Self-diagnosis 0407 (ps) (Actual value: 0.417)
AN 0407 3 \ctua
40D 0.407 |
I 0407 il val
0407 }
0407 3
L J 0407 |
| I 0.407 3
I 0407 3l val
I I I I 0.407 }
I i 5 3
! 30 5 3l val

(Total conversion time: 1.479us)

Event link control setting

ELC scan end event generation condition On completion of all scans v

Figure 4-46 Config_S12AD0 setting (3)
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4.7 The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed using the Pins page.

Pin configuration

Hardware Resource CR=R Y
| |
X Al N
W Clock generator .
~ W Voltage detection circuit
w VD2
@ Clock frequency accuracy measurement circuit
@ Operating mode control
2 System control
@ On-chip emulator
o Interrupt controller unit
« & Multi-function timer pulse unit 2
w MTUO
= MTU1
w MTUZ
w MTU3
w MTU4
w MTUS
4 Port output enable 2
(@ Realtime clock
v (@ B-bit timer v |

Pin Function Pin Number
Overview Board |Clocks | Systemn Ccmpunentslntenupts
Figure 4-47 The ‘Pins’ tabbed page

4.71 Change pin assignment of a software component

To change the pin assignment of a software component in the Pin Function list, click 5% to change view to
show by Software Components.

Pin configuration

Hardware Resource 2T f'al a5
: :
|

Figtjre 4-48 Change view to show by Hardware Resource
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Select the Config_SCI1 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD1 and TXD1 are checked and Assignment column of RXD1 is P30 and TXD1 is P26
as shown in Figure 4-49.

Software Components + = %5 PinFunction U R AT
| Type filter text l il'_.-'r;u filter text (* = any string, 7 = any character) | All v
v & rbsp Enabl.. Function Assignment Pin Number Direction Remar|
™ rbsp O crs1# # Mot assigned # Mot assigne None
v & 8-Bit Timer [1 R1s1# # Not assigned # Not assigne None
@ Config_TMRD RXD1 [ P30/MTIOCB/TMRIZ/POEB#/RXD 1/5MIS(] # 18 |
* & Compare Match Timer O sckr # Not assigned # Not assigne None
@ Conlig CMTH TXD1 |#_p2é/MTIOC2A/TMO1/LPTO/TXD 1/5MOSIT] # 20 o
w Config_CMT1
v & Interrupt Controlier
& Config_ICU
~ & Ports
@ Config_PORT
w & SCIfSCIF Asynchronous Mode
| & Config_SCI1 |
v J% SPI Clock Synchronous Mode (3-wire method)
@ Config_SCI6
v % Single Scan Mode S12AD
@ Config_512AD0
< >

Pin Function Pin Number

Figure 4-49 Configure pin assignment - Config_SCI1

Select the Config_SCI6 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is PB3, SMOSI6 is PB1
as shown in Figure 4-50.

Software Components + = 1% g4 Pin Function LU R TR

Type filter text il'_.'pe filter text (* = any string, 7 = any character) | All s

v & rbsp Enabl.. Function Assignment Pin Number Direction Remarl
= r_bsp SCK6 I.*r PBS,FMTIOCDA;MTIDCANTMOD;POES#;LFI! 45 o]

4% 8-Bit Timer [ sMmIso6 # Not assigned # Mot assigne None
w Config_TMRO SMOSI6 |7 PB1/MTIOCOC/MTIOCAC/ TMCID/TXDE/SM| # 47 10

~ & Compare Match Timer SS6# # Not assigned # Mot assigne None
w Config_CMTO

w Config_CMT1
2 Interrupt Controller
& Config_ICU
& Ports
@ Config_PORT
4% SCI/SCIF Asynchronous Mode
& Config_SCI1

w % SPI Clock Synchronous Mode (3-wire method)
& Config 5CI6 I

v % Single Scan Mode S12AD
& Config_S12AD0

<

£
Ol

€

¢

Pin Function Pin Number

Figure 4-50 Configure pin assignment - Config_SCI6
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Select the Config_ICU of Software Components. In the Pin Function list -> Assignment column, change the
pin assignment IRQ1 to P31, IRQ2 to P32. Ensure the ‘Enable’ tick box of IRQ1 and IRQ2 are checked, as

shown in Figure 4-51.

Software Components # = % &%  Pin Function 2D H G| ke
jT}‘pt‘ filter text | |1ype filter text (* = any string, ? = any character) | All v
v aa r_bsp Enabl.. Function Assignment Pin Mumber Direction Remar|
= rbsp [J IrQO # Not assigned # Not assigne None
v &% B-Bit Timer ] ran 7 P31/MTIOCAD/TMCI2/CTS 1#/RTS 1#/551#] # 17 [
w Config TMRO [] rQ2 7 P32/MTIOCOC/ TMO3/TXD6/SMOSIB/SSDY # 16 I
v & Compare Match Timer O IrG3 # Not assigned # Not assigne None
w Config_CMTO 0 IrRG4 7 Not assigned 7 Not assigne None
w Config CMT1 [J IrRQS 7 Not assigned # Not assigne None
& Interrupt Controller [0 Irae # Not assigned # Not assigne None
@ Config_ICU 0 mwrav # Not assigned # Not assigne None
v& Ports O nm # Not assigned # Not assigne None
@ Config_PORT
v % SCIfSCIF Asynchronous Mode
@ Config_SCI1
~ 2 SPI Clack Synchronous Mode (3-wire method)
@ Config_SCI6

v & Single Scan Mode 512AD
& Config_S12AD0

Pin Function Pin Number

Figure 4-51 Configure pin assignment - Config_ICU

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of ADTRGO#, ANOOO are checked and Assignment column of AN0OO is P40, ADTRGO# is

P16 as shown in Figure 4-52.

Software Components # = % & Pin Function 2D H| D s
:T','!JI:‘ filter text . !13:;;::- filter text (* = any string, ? = any character) | All v
v 4% 1 bsp Enabl.. Function Assignment Pin Number Direction Remar|
w r_bsp ADTRGO#  [F P16/MTIOCIC/MTIOC3D/TMO2/TXD 1/5M] # 24 |
v &% B-Bit Timer ANOOD 7 P40/ANDOO £ 75 |
= Config_TMRO [0 AN0O1 ¥ Mot assigned ¥ Not assigne None
~ & Compare Match Timer [0 ANDO2 # Not assigned # Not assigne None
= Config CMTO [0 AN0OO3 # Not assigned # Mot assigne Nane
~ Config CMT1 [0 ANCO4 # Mot assigned # Mot assigne None
v & Interrupt Controller [0 AMNOOS # Not assigned # Not assigne None
& Config_ICU [0 ANQO6 # Not assigned # Not assigne None
v & Ports [0 Anoo7 # Not assigned # Mot assigne None
@ Config_PORT [0 AND16 7 Not assigned # Mot assigne None
v & Sl_'_'I,FSCIF Asynchronous Mode [0 ANO17 # Not assigned # Not assigne None
@ Config_SCI1 [0 AND8 7 Not assigned # Not assigne None
~ 2 SPI Clack Synchronous Mode (3-wire method) [ ] AND19 # Not assigned # Not assigne None
@ Config_SCI6 [1 ANO20 # Not assigned # Not assigne None
v & Si\ngle Scan Mode 512AD [0 AN021 # Not assigned # Mot assigne Nane
& Config S12AD0 ] [0 AN024 # Not assigned # Mot assigne None
[0 AND25 # Mot assigned # Not assigne None
[ ANO26 # Not assigned ¥ Mot assigne None
[0 VREFHO # Mot assigned # Mot assigne None
[ VREFLO # Not assigned # Mot assigne None
< >
| Pin Function Pin Number
Figure 4-52 Configure pin assignment - Config_S12AD0
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Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘®elGenerate Code’ at location of Figure 4-53.

[ =
B

Pin configuration Generate Code | Generate Report

Figure 4-53 Generate Code Button

The Console pane should report ‘Code generation is successful’, as shown Figure 4-54 below.

B Console A #E8~0O~=0O
Smart Configurator Qutput
M@40BRaB1: File generated:src'smc gen\Config SCI1\Config SCI1 user.c ~

MA4PBRA01: File penerated:src\smc gen‘\Config SCI6\Config SCI6.h
MBABPABA1: File generated:src\smc gen‘\Config SCI6\Config SCI6.c
MOA0BRAB1: File generated:srclsmc gen\Config SCI6\Config SCI6 user.c
MO40Bed01: File generated:src\smc gen\Config $12AD@\Config S12ADG.h
MB4PBRA01: File penerated:src\smc gen\Config S12AD@\Config S12AD8.c
MPABPABA1: File generated:src\smc gen\Config S12AD@\Config S12AD8 user.c
MOA0Bead1: File generated:src\smc gen\general\r cg macrodriver.h
MO40Bead1: File generated:src\smc gen\general\r cg userdefine.h
MR4PPRAA1: File penerated:src\smc gen\generallr smc entry.h

MA4BPAAA1: File generated:src\smc gen\generallr cg hardware setup.c
MOA0RRad1: File generated:src\smc gen\general\r cg cmt.h

MO40Bead1: File generated:src\smc gen\general\r cg tmr.h

MR40PR001: File penerated:src\smc gen‘\general\r cg icu.h

MO40BRad1: File generated:src\smc gen\general\r cg port.h

MOA0PRad1: File generated:src\smc gen\general\r cg s12ad.h

M@408@eal: File generated:srcl\smc gen\general\r cg sci.h

MR5000012: File penerated:src\smec gen\r pincfg\Pi
MB5000012: File generated:src\smc gen\r pincfg\Pin.c
MO60Bead2: File generated:src\smc gen\general\r smc interrupt.c

MO60Bea02: File generated:src\smc gen\general\r smc interrupt.h

MO3000004: File modified:src\smc gen\r config\r bsp config.h

MOOoBRAd2: Code generation is successful:C:\Workspace\SC Tutoriallsrcl\smc gen

Figure 4-54 Smart Configurator console
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4.8

Building the Project

The project template created by Smart Configurator can now be built. In the Project Explorer pane expand the

‘src’ folder then smc_gen folder.

B Project Explorer x = ] T

~ 15 SC_Tutorial [HarﬂwareDehug]
m! Includes
~ & src
v & smc_gen
& Config_CMTO
& Config_CMT1
& Config_iCu
& Config_PORT
& Config_S12AD0
& Config_sCI
= Config_SCl6
= Config_TMRO
= general
& rbsp
& r_config
& r_pincfg
e 5C_Tutonal.c
& trash
& SC_Tutonal scfg
5C_Tutorial HardwareDebug.launch

Figure 4-55 Generated folder structure

Switch back to the ‘C/C++’ perspective using the i button on the top right of the e? studio workspace.

Select SC_Tutorial in the Project Explorer pane, then use ‘Build Project’ from the ‘Project’ menu or the

button to build the tutorial. The project will build with no errors.

& -
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5. User Code Integration

In this section, the remaining application code is added to the project. Source files found in the RSK Web
Installer are copied into the workspace and the user is directed to add code in the user areas of the code

generator files.

Code must be inserted into the user code area within many Smart Configurator-generated files in this project,
these user code areas are delimited by comments as follows:

/* Start user code for _xxxxx .
/* End user code.

Do not edit comment generated here */
Do not edit comment generated here */

Where xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart

Configurator-generated code.

5.1 Project Settings

e Change the optimization level of the
build configuration 'HardwareDebug'
before building the project. With the
SC_Tutorial project selected, right-
click and select [Properties], or use
the shortcut keys [Alt] + [Enter] to
open the Properties window.

B Project Explorer »

~ 15 SC Tutorial [HardwareDet---"

¥ Binaries
e Includes
v B src

= smc_gen
& SC_Tutonal.c

= HardwareDebug

& trash
SC_Tutonal.rcpe

& SC_Tutonal.scfg
SC_Tutonal HardwareD

Mew
Go Into

Open in New Window
Show In

Show in Local Terminal
Copy

Delete

Source

Rename..

Impaort...

i Export..

3# 0

=

L R

Build Project
Clean Project
Refresh

Close Project

Close Unrelated Project

Build Targets

Index

Build Configurations

Run As

Debug As

Team

Compare With

Restore from Local Histony..
MISRA-C

C/C++ Project Settings
Renesas C/C++ Project Settings
Run C/C++ Code Analysis
System Explorer

Command Prompt
Configure

Properties

Alt+Shift+W >
»

Ctri+C
Ctrl+V
Delete

>

F2

F5

>

Ctri+Alt+P
»

Alt+Enter

R20UT5032EG0100 Rev.1.00

Jan.17.2022

RENESAS

Page 52 of 80




Renesas Starter Kit for RX140

5. User Code Integration

¢ Navigate to ‘C/C++ Build -> Settings
->Compiler -> Optimization.

e Select 'Level 0: Do not perform
optimization' from the Optimization
level pull-down.

Settings

Configuration: HardwareDebug [ Active | ~| | Manage Configurations..

® Tool Settings Toolchain Device /* Build Steps * Build Artifact [l Binary Parsers @ Error Parsers

» Common
=)
(2 PIC/PID
3 Miscellaneous
 ® Compiler
~ (% Source
& Advanced
@ Object
& List
~ (% Optimization
(3 Advanced

Optimization level (-optimize)

] Outputs additional information for inter-module optimization (-goptimize) rform optimization

| optimization
Optimization type (-speed/-size) e module optimization
Level max: Perform all applicable optimizations

Perform loop optimization (-160p)

Performs inline expansion automatically (-inline/-noinline) Depends on the optimization option

Reduces code size of relative branch instructions (-branch_chaining/-nobranch_chaining) | Depends on the optimization option v

e Press the ‘Apply and Close’ button to
close Properties window.

Apply and Close Cancel

R20UT5032EG0100 Rev.1.00
Jan.17.2022

RENESAS Page 53 of 80




Renesas Starter Kit for RX140 5. User Code Integration

5.2 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-ascii.c
-ascii.h
-r_okaya_lcd.c
-r_okaya_lcd.h

Copy these files in to the src folder below the workspace. These files will be automatically added to the

project as shown in Figure 5-1.

w =% SC_Tutorial [HardwareDebug]
[l Includes
v [ src

(= smc_gen
[ ascii.c
[B] asciih
@ r_okaya_lcd.c
r_okaya_lcd.h
[ SC_Tutorial.c

Figure 5-1 Adding files to the project

In the e? studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’ by
double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area for include near the top of the file:
/* Start user code for include. Do not edit comment generated here */
#include "platform.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the type define.
/* Start user code for type define. Do not edit comment generated here */
typedef char char t;

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src’ folder and open the file ‘SC_Tutorial.c’ by double-clicking on it.
Add header files near the declaration ‘#include r_smc_entry.h’.

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
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Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)" RSKRX140 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");
while (1U)

{

}

Indentation is lost when the code described in this manual is pasted into the e? studio source file. Also check that
the pasted code is correct.
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5.21 SPICode

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in section
4.6.7. In the e studio Project Tree, expand the ‘src\smc_gen\Config_SCI6’ folder and open the file
‘Config_SCI6.h’ by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */
Now, open the Config_SCI6_user.c file and insert the following code in the user area for global:
/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t s _sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:

static void r Config SCI6 callback transmitend(void)
{
/* Start user code for r Config SCI6 callback transmitend. Do not edit comment generated here */

s_sci6 txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

JR KKK KKKAK KKK A KKK KK KKK KARK LA A KKK KK KKK AAKA LA A A A KKK KKK AAAX KL LA A& KKk k kK KKK *

* Function Name: R _SCI6_ SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num)

{
MD STATUS status = MD OK;

/* Clear the flag before initiating a new transmission */
s sci6 txdone = FALSE;

/* Send the data using the API */
status = R Config SCI6 SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s sci6_txdone)
{
/* Wait */
}

return (status);

}

VAR EEEEE RS LA R EE RS AR E R R R

* End of function R SCI6 SPIMasterTransmit
*******************************************************************************/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD and is used as the main API call in the LCD code module.
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5.22 TMR Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in section 4.6.2. Open the file
‘src\smc_gen\Config_ TMRO\Config' TMRO.h’ and insert the following code in the user area for function at the
end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_TMR MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ TMRO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t s one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config_ TMRO_cmiaO_interrupt function and insert the following line in the user code
area:

static void r Config TMRO cmiaO interrupt (void)
{
/* Start user code for r Config TMRO cmiaO_interrupt. Do not edit comment generated here */

s_one_ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/******************‘k*************************‘k**‘k‘k‘k*‘k**********************‘k‘k***
* Function Name: R TMR MsDelay

* Description : Uses TMRO to wait for a specified number of milliseconds

* Arguments : uintl6 t millisecs, number of milliseconds to wait

* Return Value : None
*******************************************************************************/
void R_TMR MsDelay (const uintlé6_t millisec)

{
uintl6é_t ms_count = 0;

do
{
R Config TMRO Start();
while (FALSE == s_one ms _delay complete)
{
/* Wait */
}
R Config TMRO Stop();
s_one_ms_delay complete = FALSE;
ms_count++;
} while (ms_count < millisec);

}

/***********************‘k‘k****‘k‘k************************************************

End of function R TMR MsDelay

LR R R R EEEE R e R E R R EE Ry
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5.3 Additional include paths

Before the project can be built the compiler needs some additional include paths added. Select the
SC_Tutorial project in the Project Explorer pane. Right click in the Project Explorer window and select

'Properties’. Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the €] button as shown in
Figure 5-2.

& Properties for 5C_Tutorial O X |

type filter text Settings = .8
Resource =
Builders

v C/C++ Build Configuration: HardwareDebug [ Active | ~| [Manage Configurations...

Build Variables

Environment =
® Tool Settings Toolchain Device # Build Steps Build Artifact [ Binary Parsers @ Error Parsers

Logging
Settings |+ & Common Include file directories (-include) = w =
S RE ®cu S
Tool Chain Editor & PIC/PID “${workspace_loc;/${ProjNamel/src/smec_gen/Config_CMTO}"
C/C++ General (5 Miscellaneous “${workspace_loc;/${ProjName}/src/smc_gen/Config_SCI6}"
Project Natures | v B Compiler “${workspace_loc:/${ProjNamel/src/smc_gen/general}”
Project References « (% Source “${workspace_loc;/${ProjNamel/src/smc_gen/Config_CMT1}"
Renesas QF & Advanced “${workspace_loc;/${ProjName)/src/smc_gen/Config_ICU}"
Rur/Debug Settings B Object :S[workspace_loc:,fﬂPrOJNamei-f;rc,fsmc_gen,fconhg_s1ZADE;}--
- ) ${workspace_loc:/${ProjName)/src/smc_gen/Config_TMRO}
& List “${workspace_loc/${ProjNamel}/src/smc_gen/Config_PORT}"
~ (& Optimization “${workspace_loc;/${ProjName}/src/smc_gen/Config_SCI1}"
(= Advanced “${workspace_loc;/${ProjName}/src/smc_gen/r_pincfg}”
{2 Output “${workspace_loc:/${ProjName]}/src/smc_gen/r_bsp}” o
(£ MISRA C Rule Check e ..n,,m.nm.mﬂ..m-.f,,, femcsgni bt
(8 Miscellaneous Pre-include files (-preinclude) L2
% User
~ B Assembler -
B Crvirrn

Figure 5-2 Adding additional search paths

In the ‘Add directory path’ dialog, click the ‘Workspace...” button and in the ‘Folder selection’ dialog browse to
the ‘SC_Tutorial/src’ folder and click ‘OK’. e? studio formats the path as shown in Figure 5-3 below.

{8} Add directory path *

Directory:

' $iworkspace_loc/${ProjName}/src)

[] Add subdirectories

oK Cancel File system...

Figure 5-3 Adding workspace search path

Close the property by clicking the 'Apply and Close' button shown in Figure 5-2, and when the 'Settings'
dialog shown in Figure 5-4 is appeared, click 'Yes' to finish the setting.

C s 2t N
SETNgs s

Changes made will not be reflected in the index until it is rebuilt. Do you wish to rebuild it
now?

[ | Remember my decision

Yes No

Figure 5-4 Settings dialog
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-

Select ‘Build Project’ from the ‘Project’ menu or use the button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in section 6. The program will display
‘RSKRX140 Tutorial Press Any Switch’ on three lines in the LCD display.
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5.4 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rskrx140def.h
-r_rsk_switch.c
-r_rsk_switch.h

Copy these files in to the src folder below the workspace.

The switch code uses interrupt code in the files Config_ICU.h, Config_ICU.c and Config_ICU_user.c and timer
code in the files Config_ CMTO0.h, Config_ CMTO.c, Config_CMTO_user.c, Config_ CMT1.h, Config_ CMT1.c and
Config_ CMT1_user.c as described in section 4.6.2. and section 4.6.4 It is necessary to provide additional
user code in these files to implement the switch press/release detection and de-bouncing required by the API
functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_ICU’ folder and open the file ‘Config_ICU.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */

uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);

void R_ICU TRQSetRisingEdge (const uint8_t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */
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Now, open the Config_ICU.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************

* Function Name: R ICU IRQIsFallingEdge

Description : This function returns 1 if the specified ICU IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8 t irqg no

* Return Value : 1 if falling edge triggered, 0 if not

*******************************************************************************/
uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no)
{

uint8 t falling edge trig = 0x0;

if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE FALLING)

{
falling edge trig = 1;
}

return (falling edge trig);

KKK K K K K Kk K KR K K K R K K K R K K K R K K R R K K R kK R K K ok Kk ok Kk ok ok K R ok Kk ok kK K ok Kk ok Kk R kK ok ok kR kK ok ok ok

* End of function R _ICU IRQIsFallingEdge

*******************************************************************************/

KK KKK K K K K K K R K K K R K K ok K K R R K K R K K K ok K R kK ok K K K ok Kk ok K ok K K R K K K R K K R kK K R kK R R kR ok K K Rk

* Function Name: R _ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_ IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if
* clearing

* Return Value : None
*******************************************************************************/

void R _ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set_f edge)
{
ICU.IRQCR[irg nol] .BYTE |= 04 ICU IRQ EDGE FALLING;
}

else

{
ICU.IRQCR[irq no].BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

VAR AR EEEEE RS AR AR EEEE AR R AR R R R R R

* End of function R_ICU_IRQSetFallingEdge

*******************************************************************************/

VAR EEEE R RS LA AR EEEEE e R E R R E R

* Function Name: R_ICU_ IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
* specified ICU_IRQ.
* Arguments : uint8 t irg no
* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing
* Return Value : None
*******************************************************************************/

void R_ICU IRQSetRisingEdge (const uint8 t irg no, const uint8 t set r edge)
{
if (1 == set r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE_RISING;
}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;

}

/******************************************************************************

* End of function R ICU IRQSetRisingEdge

******************************************************************************k/

/* End user code. Do not edit comment generated here */
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Open the Config_ICU_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irq1_interrupt:

/* Start user code for r Config ICU irgl interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R _SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg2_interrupt:

/* Start user code for r Config ICU irg2 interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R_SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */

5.4.2 De-bounce Timer Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMTO’ folder and open the
‘Config_ CMTO_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the Config_ CMTO_user.c’ file, insert the following code in the user code area inside the function
r_Config_ CMTO_cmi1_interrupt:

/* Start user code for r Config CMTO cmiO interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R _Config CMTO_ Stop();

/* Call the de-bounce call back routine */
R _SWITCH DebounceIsrCallback();

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT1’ folder and open the file
‘Config_ CMT1_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */
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In the same file insert the following code in the user code area inside the function
r_Config_CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R_SWITCH DebounceIsrCallback();

/* End user code. Do not edit comment generated here */

543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In section 4.6.8 we configured the ADC to be triggered from the ADTRGO0# pin, SW3.
In this code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e2 studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’.
Insert the following code the user code area, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */
extern volatile uint8_t g _adc_trigger;

/* End user code. Do not edit comment generated here */

In the e2 studio Project Tree, expand the ‘src’ folder and Open the file ‘SC_Tutorial.c’ and add the highlighted
code, resulting in the code shown below:

#include
#include
#include "r cg ucs >
#include "Config S12ADO.h"
#include "r rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the

code shown below:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R_LCD Init ();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX140 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0O_Start();

while (10U)
{
uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SWl1 or SW2)

if (TRUE == g adc_ trigger)

{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();

/* Display the result on the LCD */
lcd display adc (adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

*/
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Then add the definition for the switch call-back, get_adc and lcd_display_adc functions below the main

function, as shown below:

/******************************************************************************

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument : none
* Return value : none

LR EEEEEEE SRR EEEE Rt EE R EEEE SRR EE R

static void cb_switch press (void)

{
/* Check if switch 1 or 2 was pressed */
if (g_switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))
{

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_ flag = 0x0;
}
}

/******************************************************************************

* End of function cb switch press
******************************************************************************/

/******************************************************************************

Function Name : get_ adc
* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.
* Argument : none
* Return value : uintlé_t adc value

******************************************************************************/
static uintlé t get adc (void)

/* A variable to retrieve the adc result */
uintlé_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12AD0 Stop();

/* Start a conversion */
R S12AD0_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g adc complete)
{
/* Wait */
nop () ;
}

/* Stop conversion */
R_S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g_adc_complete = FALSE;

R _Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R _Config S12AD0_Start();

return (adc_result);

}

/******************************************************************************

* End of function get adc
khkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhkhhhhhhhhkhhkhkhkhkhkhhkhhhhhhhhhkhkhkhkhkhkkkkkkkk
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/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/
static void lcd display adc (const uintl6 t adc result)

{
/* Declare a temporary variable */
char t tmp;

/* Declare temporary character string */
char t lcd buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

tmp = (char t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) ((adc_result & 0x00F0) >> 4);

lcd buffer[7] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) (adc_result & O0xO000F);

lcd buffer[8] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);

/* Display the contents of the local string lcd buffer */
R_LCD Display(3, (uint8 t *)lcd buffer);
}

/**k*****k*********k******************************************kk***************

* End of function lcd display adc

******************************************************************************/

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_S12AD0’ folder and open the file

‘Config_S12AD0.h’ by double-clicking on it. Insert the following code in the user
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R S12AD0 SWTriggerStart (void);
void R _S12AD0_SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */

code area for function,

R20UT5032EG0100 Rev.1.00 RENESAS
Jan.17.2022

Page 66 of 80



Renesas Starter Kit for RX140 5. User Code Integration

Open the file ‘Config_S12AD0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R_S12AD0_SWTriggerStart

* Description : This function starts the ADO converter.

* Arguments : None

* Return Value : None
*******************************************************************************/

void R _S12AD0_SWTriggerStart (void)

{
IR(S12AD, S12ADIO) = 0U;
IEN(S12AD, S12ADIO) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;
}

JE KKK KKK KKKk h ki h Kk kKA A AR KR KA A K KKK I I I A A AR AKX A A KAk Ak ok hh kA AR XA A I KAk ok ok khh kA XXX

End of function R S12AD0 SWTriggerStart

*******************************************************************************/

[ E KKK KA KKK KKKk hh kI AR AR Kk Kk hhh kA A AR AR A A A A KK A KKK I I A AR AR XA A A Kk kk ok h ok kA XXX

* Function Name: R _S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None

* Return Value : None
*******************************************************************************/

void R_S12AD0_SWTriggerStop (void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN (S12AD, S12ADIO) = 0U;
IR(S12AD, S12ADIO) = 0U;

}

VAR AR R RS R R SR AR AR RS Rt R EEEEE Rt R EEEE R R

End of function R S12AD0_ SWTriggerStop

*******************************************************************************/

/* End user code. Do not edit comment generated here */

Open the file Config_S12ADO0_user.c and insert the following code in the user code area for global, resulting in
the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_ S12ADO0 _interrupt function, resulting in the
code shown below:

static void r Config S12AD0_interrupt (void)
{

/* Start user code for r Config S12AD0 interrupt. Do not edit comment generated here */
g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

-

Select ‘Build Project’ from the ‘Project’ menu or use the button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in section 6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the RV1 potentiometer line and display the
result on the LCD panel. Return to this point in the Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

r_rsk_debug.c

r_rsk_debug.h

Copy these files in to the src folder below the workspace.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R SCI1 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_SCI1’ folder and open the file ‘Config_SCI1.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R _SCI1 AsyncTransmit (uint8 t * const tx buf, const uintl6_t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI1_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t s scil txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI1_callback_transmitend function:
static void r Config SCI1 callback transmitend (void)
{
/* Start user code for r Config SCI1 callback transmitend. Do not edit comment generated here */

s_scil txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area inside the
r_Config_SCI1_callback_receiveend function:

static void r_Config SCI1_callback_receiveend(void)

{

/* Start user code for r Config SCI1_callback receiveend. Do not edit comment generated here */

/* Check the contents of g _rx char */
if (('c' == g rx char) || ('C' == g rx char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI1 receive buffer and callback function again */
R Config SCI1 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/*******************************************************************************

* Function Name: R SCI1 AsyncTransmit

* Description : This function sends SCI1 data and waits for the transmit end flag.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

*******************************************************************************/
MD STATUS R_SCI1 AsyncTransmit (uint8_t * const tx buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s_scil txdone = FALSE;

/* Send the data using the API */
status = R Config SCI1 Serial Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == s_scil_ txdone)
{
/* Wait */
}
return (status);

}

/*******************************************************************************

* End of function R SCI1 AsyncTransmit

*******************************************************************************/

5.6.2 Main UART code

Open the file ‘SC_Tutorial.c’. Add the following declaration to near the top of the file:

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI1.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

R20UT5032EG0100 Rev.1.00 RENESAS
Jan.17.2022

Page 69 of 80



Renesas Starter Kit for RX140 5. User Code Integration

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc_count = 0;

Add the following highlighted code in the main function:

void main (void)

{
/* Initialize the switch module */
R _SWITCH Tnit();

/* Set the call back function when SWl or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)" RSKRX140 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R _Config S12AD0_Start();

/* Set up SCI1 receive buffer and callback function */
R Config SCI1 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI1 operations */
R Config SCI1 Start();

while (10)
{

uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SWl1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc count */
if (16 == (++s_adc_count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc_count, adc result);

/* Reset the flag */

g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc_complete)
{

/* Get the result of the A/D conversion */
R_Config S12AD0O_Get_ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc result);

/* Increment the s_adc count */
if (16 == (++s_adc_count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc_count, adc_result);
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/* Reset the flag */
g adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition in the end of the file:

VAR SRR AR AR EE RSt R e R Rttt e e R R Rttt AR EEE R

* Function Name : uart display adc
* Description : Converts adc result to a string and sends it to the UART.
* Argument : uint8 t : adc count

*

uintlé t: adc result

* Return value : none
******************************************************************************/

static void uart display adc (const uint8 t adc count, const uintl6 t adc result)

{

}

/* Declare a temporary variable */
char_t tmp;

/* Declare temporary character string */
char t uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

tmp = (char_t) (adc_count & 0x000F);

uart buffer[4] = (tmp < O0xO0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) ((adc_result & 0x0F00) >> 8);

uart buffer([14] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) ((adc_result & 0xO00F0) >> 4);

uart buffer([15] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) (adc_result & 0x000F);

uart buffer[l6] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);

/* Send the string to the UART */
r _debug print (uart buffer);

/*******************************‘k‘k‘k‘k‘k******************************************

* End of function uart display adc
**************‘k‘k‘k‘k‘k**‘k‘k‘k‘k******‘k‘k‘k***************‘k‘k‘k‘k‘k‘k*****‘k‘k‘k***************/

Select ‘Build Project’ from the ‘Project’ menu. e? studio will build the project with no errors.

The project may now be run using the debugger as described in section 6. Connect the RSK G1CUSBO port
to a USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will
be installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &
LPT)" as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI1 (Baudrate:
19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).

When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion

of the voltage level on the RV1 potentiometer line and display the result on the LCD panel and send the result
to the PC terminal program via the SCI1.
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5.7 LED Code Integration

Open the file ‘SC_Tutorial.c’. Add the following declaration to the near the top of the file:

#include "r smc entry.h"
finclude "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
finclude "r rsk debug.h"
#include "Config SCI1.h"
#include "rskrxl140def.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6_t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc_ result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s adc count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code in the main function:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R _SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX140 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI1 receive buffer and callback function */
R Config SCI1 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI1 operations */
R Config SCI1 Start();

while (10)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc_result);
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/* Increment the s _adc count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display_count (s_adc_count) ;

/* Send the result to the UART */
uart display adc(s_adc_count, adc result);
/* Reset the flag */
g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R_Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s _adc count);

/* Send the result to the UART */
uart display adc(s_adc count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition at the end of the file:

VAR AR EEEEE S SRR R EEE RSt E Rttt AR EEEE Rt

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDSO0-3
* Argument : uint8 t count

* Return value : none

LR R EEEEEE AR EEEEE SRR EEE RS RSt

static void led display count (const uint8 t count)

{

/* Set LEDs according to lower nibble of count parameter */

LEDO = (uint8_t) ((count & 0x01) ? LED ON : LED OFF);
LED1 = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8_ t) ((count & 0x04) ? LED ON : LED OFF);
LED3 = (uint8_t) ((count & 0x08) ? LED ON : LED OFF);

}

/**********************************************~)<~)<~)<~)<~)<~)<~k~k************************

* End of function led display count
ER R R kb ik Sk ik b b bk b b h b bk R R R R b b b b b b Rk R R R R e

%

Select ‘Build Project’ from the ‘Project’ menu or use the
errors.

" button. e? studio will build the project with no

The project may now be run using the debugger as described in section 6. The code will perform the same

but now the LEDs will display the s_adc_count in binary form.
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6. Debugging the Project

In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To enter the configurations,

click upon the arrow next to the debug button: #‘FE and select ‘Debug Configuration’.

| Create, manage, and run configurations @

L X B8V~ NarnefSC_Tutorial HardwareDebug

type filter text = =
| = _TJ Debugger | ¥ Startup| - Source| ] Common
[€] C/C++ Application

| - Project:
| £] C/C++ Remote Application
EASE Script SC_Tutorial Browse...
[€] GDB Hardware Debugging C/C++ Application:

|
|

| GDB Simulater Debugging (RHB50)
| ;'1 Al “J ugging { HardwareDebug/SC_Tutorial x

| Bica. Variabl Search Project. B

| [T Java Application ariables... arch Project... TOWSE...
|

|

& Launch Group Build (if required) before launching
T, Remote Java Application

= Build Configuration: | Select Automaticall ~
|| ~ [ Renesas GDB Hardware Debugging : Li
] SC_Tutorial HardwareDebug (O Enable auto build () Disable auto build
[ Renesas Simulator Debugging (RX, RL78) (® Use workspace settings Configure Workspace Settings..

Filter matched 12 of 14 items

Figure 6-1 Debug Configurations

In order to execute the project, it is necessary to change the following settings in ‘Renesas GDB Hardware
Debugging’ -> ‘SC_Tutorial HardwareDebug’ -> ‘Debugger’ -> ‘Connection Settings’.

Set ‘Power Target From The Emulator (MAX 200mA)’ to ‘Yes’, set ‘Extal Frequency [MHz] and 'Operating
Frequency [MHZz]' to the correct frequency. (They should not use the 'Enter' key after typing in values.)

These can be found from the device schematics (in the case of RSKRX140 set the EXTAL Frequency: 8.0000,
Operating Frequency: 48.000).

For more information on powering the RSKRX140 please refer to the User’'s Manual.

Name: .SC_Tutorlal HardwareDebug
B Main_ ¥ Startup | % Source ] Common

Debug hardware: E2 Lite (RX) ~ Target Device: R5F51406

GDB Settings| Debug Tool Settings

v Clock ~
a XTAL v

Extal Frequency[MHz] 8.0000
Operating Frequency [MHz] 48
Permit Clock Source Change On Writing Internal Flash Memory Yes W

v Connection with Target Board
Emulator (Auto)
Connection Type Fine
JTag Clock Frequency[MHz] 6.00
Fine Baud Rate[Mbps] 1.50 v
Hot Plug No

v Power
Power Target From The Emulator (MAX 200mA) Yes v
Supply Voltage (V) 3

w CPU Operating Mode
Register Setting [
Mode pin gle-chip mode v

Figure 6-2 Connection Settings

When the setting is complete, press the 'Apply' button followed by the "Close" button to close the debug
configuration window.
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Connect the E2 Lite to the PC and the RSK E2 Lite connector. Connect the Pmod LCD to the PMOD1
connector. Connect the center positive +5V PSU to the PWR connector on the RSK and apply power.
In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To debug the project, click the

button. The dialog shown in Figure 6-3 will be displayed.

b

'o This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for displaying
the debug stack, vanables and breakpoints.

Switch to this perspective?

[] Remember my decision

[

Figure 6-3 Perspective Switch Dialog

Click ‘Remember my decision’ to skip this dialog later. Click ‘Switch’ to confirm that the debug window
perspective will be used. The debugger will start up and the code will stop at the Smart Configurator function
‘PowerOn_Reset PC’ as shown in Figure 6-4.

Q Workspace - SC_Tutorial/src/smec_gen/r_bsp/mcu/all/resetprg.c - e* studio
File Edit Source Refactor MNavigate Search Project RenesasViews Run Window Help
& || 4 || ™ | |4 Debug v || E7 SC_Tutorial HardwareDebug ™ g BrR~m BDiw|oum

v Ol w0

= - |

1+ Debug x = = §
« [ SC_Tutorial HardwareDebug [Renesas GDB Hardware Debugging]
v ¥ SC_Tutorialx [1] [cores: 0]
~ i Thread #1 1 (single core) [core: 0] (Suspended : Signal : SIGTRAP:Trace/breakpoint trap)
= PowerON_Reset_PC() at resetprg.c:191 Oxfffc29a2
wi mx-elf-gdb -rx-force-v2 (7.8.2)
! Renesas GDB server (Host)

resetprg.c x =

> - R_BSP_POR_FUNCTION(R_BSP_STARTUP_FUNCTION)

* and construct
- #if defined(__GNUC_ )
- #if BSP_CFG_USER_STACK_ENABLE == 1
INTERNAL_NOT_USED(ustack_area);

Figure 6-4 Debugger start up screen

For more information on the e? studio debugger refer to the Tutorial manual. To run the code click the L
button. The debugger will stop again at the beginning of the main function. Press B again to run the code.
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7. Additional Information

Technical Support

For details on how to use e? studio, refer to
the help file by opening e? studio, then :
selecting Help > Help Contents from the 0~ B WO f

menu bar. (7). Help Contents
Search

Show Context Help |

Window Help

For information about the RX140 group microcontroller refer to ‘RX140 Group User’s Manual: Hardware’.
For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details
America: techsupport.america@renesas.com

Europe: https://www.renesas.com/eu/en/support/contact.html
Global & Japan: https://www.renesas.com/support/contact.html

General information on this product can be found on the Renesas website at:
https://www.renesas.com/rskrx140

General information on Renesas microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe GmbH.

© 2022 Renesas Electronics Europe GmbH. All rights reserved.
© 2022 Renesas Electronics Corporation. All rights reserved.
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